Using Crystal Reports with Lucity

Beginner - 1

The first of a seven-part series, this workbook is designed for new Crystal Reports® users. You’ll learn
how to make small modifications to an existing report under a new report name and link your
customized report into Lucity.
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Getting Started

The Crystal Report software is what is currently used to create the standard reports provided with the
Lucity software.

To create or revise reports the user must own the Crystal Reports software. The user also needs to
have permission to make changes to the reports and add them to the system.

The desktop version of Lucity can only support the functions provided in Crystal XI. The Lucity
software can run reports created in later versions of Crystal, however; it cannot use any new
functionality. The Web version of Lucity was developed using a newer version of Crystal, Crystal 2008.
Lucity 2019 (and newer) is using Crystal 2016.

Crystal Versions ...9, 10, XI, 2008, 2011, 2013, 2016.

Crystal Reference

The tool bar icons sometimes change with the version of Crystal. Most screen shots throughout the
Help Guides capture what was provided with Crystal XI.

Standard Toolbar
Crystal XI

- & .E& &R Tz @ R M 100% - a2

New Report, Open, Save, Print, Print Preview, HTML Preview, Cut, Copy, Paste, Format Painter, Undo,
Redo, Toggle Group Tree, Field Explorer, Report Explorer, Repository Explorer, Dependency Checker,
Workbench, Find, Zoom Control, Help

Crystal 2008
NME-H SRE &S &BBEFo-0-0E &% A

New Report, Open, Save, Print, Print Preview, HTML Preview, Export, Cut, Copy, Paste, Format
Painter, Undo, Redo, Toggle Preview Panel, Field Explorer, Report Explorer, Repository Explorer,
Dependency Checker, Workbench, Find

Insert Tools Toolbar
Crystal XI

ab 2 = [y 0 % Rl @

Insert Text Object, Insert Group, Insert Summary, Insert Cross-Tab, Insert OLAP grid, Insert Subreport,
Insert Line, Insert Box, Insert Picture, Insert Chart, Insert Map

Crystal 2008

ifEE mHAN OB ke

Insert Text Object, Insert Group, Insert Summary, Insert Cross-Tab, Insert OLAP grid, Insert Subreport,
Insert Line, Insert Box, Insert Picture, Insert Chart, Insert Map, Insert Flash Object
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Formatting Toolbar
Crystal XI

Arial -9 -4 & BIU|E=

Font Face, Font Size, Increase Font Size, Decrease font Size, Bold, Italics, Underline, Align Left, Align
Center, Align Right, Justify, Font Color, Outside Borders, Suppress, Lock Format, Lock Size/Position,
Currency, Thousands, Percent, Increase Decimals, Decrease Decimals.

Crystal 2008

A-H-o@®

© Aial -8 A A B I DU E=EE

A-BE- BB § 1 %

Font Face, Font Size, Increase Font Size, Decrease font Size, Bold, Italics, Underline, Align Left, Align
Center, Align Right, Justify, Font Color, Outside Borders, Suppress, Lock Format, Lock Size/Position,
Currency, Thousands, Percent, Increase Decimals, Decrease Decimals.

Expert Tools Toolbar
Crystal XI

“a E & | & [x]

Database Expert, Group Expert, Group Sort Expert, Record Sort Expert, Select Expert, Section Expert,
Formula Workshop, OLAP Design Wizard, Template Expert, Format, Insert Hyperlink, Highlighting

Crystal 2008
0 2282 volo A E|EYE

Database Expert, Group Expert, Group Sort Expert, Record Sort Expert, Select Expert, Section Expert,
Formula Workshop, OLAP Design Wizard, Template Expert, Format, Insert Hyperlink, Highlighting

Navigation Tools Toolbar
Crystal XI

i [

Refresh, Stop, Show First Page, Show Previous Page, Show Next Page, Show Last Page, Back, Forward
Crystal 2008

H

Refresh, Stop, Show First Page, Show Previous Page, Show Next Page, Show Last Page
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Menu Bar
The functions of the toolbar icons are also available in the drop-down Menu Bar at the top.

£

]

File | Edit View Insert

= Open...

Format

C

New

Ctrl+0
Close
Save Ctrl+S
Save As...

Save Data with Report

Save Subreport As...

Print... Ctri+p
Page Setup...

Export

Send To

Options...
Report Options...
Sumrmary Info...

1 MaterialCost.rpt

2 RgDetmap.rpt

3 WO comments only 12-29-10.rpt
4 WOSum.rpt

5 BudgetTaskDetail.rpt

6 CauseList.rpt

7 BudgetDeptList.rpt

8 RegCountDaily.rpt

9 CatDetail.rpt

Exit
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Edit View Insert Formgt Database

)
=

Edit | View Insert

Report  Window

Forma

Can't Undo

Can't Redo

Cut Ctri+x
Copy Ctri+C
Paste Cerl+v
Paste Special...

Delete Del
Select All Crrl+A
Eind... Ctri4+F
Go To Page... Ctri+G

Edit Report Object...
Subreport Links...

Object
Links...

Help

View | Insert Format Dat

Design Ctri+D

@, Print Preview
Preview Sample...

(Gl HTML Preview
Close Current View

Field Explorer

%  Report Explorer

@ Repository Explorer

%E Dependency Checker

3 Workbench
Toolbars...

Status Bar

T=  Group Tree

3, Zoom...
Rulers 2
Guidelines k
Grid r
Toolips k




Insert | Format Database

ab
x

fi

wiE QAP 7O

Text Object

Forrmat | Database Report
S.u rnrrlarx.... & Format Field...
GEtloin <! Format Painter
Group... &, Hyperiink...
OLAP Grid... IE SR e
Cross-Tab... Highlighting Expert...
Subreport... Line Height...
Line Text Formatting...
Box Move
Picture... Align
L Make Same Size
Map... Size and Position...
OLE Object...

Template Field Object

Pivot OLAP Grid
Pivot Cross-Tab

&5

Xt

(] e

il
o A

2l

69

Report | Window

Help

Select Expert...
Selection Formulas
Formula Workshop...

Alerts

Report Bursting Indexes...

Section Expert...
Group Expert...
Group Sort Expert...
Record Sort Expert...
XML Expert...
Template Expert...

OLAP Design Wizard...
Hierarchical Grouping Options...

Show Current Parameter Values...

Tile Verticaly
Tile Horizontalty

Check Dependencias...
Refresh Report Data Fs

Cascade

Arrange Icons

Set Print Date and Time...

Performance Information...

Close All

Window | Help
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Database | Report Window

Ba  Database Expert...
Set Datasource Location...

Log On or Off Server...

&l Browse Data...

Set OLAP Cube Location...

Verify Database

Show SQL Query...

Select Distinct Records

Perform Grouping On Server

Help

License Manager...

Docurnentation

Get Add-ons fram SAP App Center...
About 5AP Crystal Reports..,

(@  SAP Crystal Reports Help F1
1 | Conted Help Shift+F1
Show Start Page
Register...

LS

1 MaterialCost.rpt



Lucity provides a Request Summary Report (ReqSum.rpt) that looks like this:

Summary of Requests Print Dat,
+ I A
7Report Subtitle Frint Tim g
E T - T v Elr T

equest # 4 [Record Dst; Status . o Status Dst; Priority . FProblem . Address
RQ_MUMBER .. @Reglate RO _STAT_TY . . @StatDate RQ FRTY_TY . RQ_PROB_TY . @@ lLocation

Total Requestsz . #TotReq ,

Preview
Summary of Requests 8172015
3:09 PM
Reguest # Record Date Status Status Date Priority Problem Address
2006-00013 4/5/2008 Completed 8/12/2006 INFO REQUEST - COMMERC IAL
2006-00022 4/5/2008 Completed 4/7/2008 COM- 40YD ROLLOFF SERVICE / 625 W GUADALUFE RD
RETURN
Total Requests: 2
We would like to modify the report to look like this:
. I
@ comment N
r - -
Summary of Requests Print Date,
hReport Subtitle ) Print Tim &
hequestNumber ::Record Date: IStalus : : Status Daté lf’ollow—Ur_l ) E:ategory: Problem: : X Coordj "y Coor\f
RQ_NUMBER .. @ReqDate RQ_STAT_TY .. @StatDate, :@FGIIG\VUDE RQ_CAT_TY . RQ_PROB_TY . RQ_X_COORD, RQ_Y_COORD,
:| Total Requests? _#TotReq . |
Eile Author K r @Page . . File Path and Name
Preview
Summary of Requests BA7/2015
2:20 PM
Request Number Record Date Status Status Date Follow-Up Category Problem X Coord Y Coord
200€-00012 4/5/2008 Completed B/12/2008 Commercisl Collection INFO REQUEST - COMMERC AL 11.22568950  12.58963200
2006-00022 4/5/2006 Completed 4/Ti2008 Commercial Collection COM- 40 YD ROLLOFF SERVICE 10.12345670 12.45678900
/RETURN
Total Requests: 2

Some of the changes include adding a company logo, changing column headers, adding text objects,
adding data fields, creating formulas and formatting.
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Custom Reports from a Standard Report

Finding the Report Location and Name - Desktop

The first step in modifying a standard Lucity report is to identify the report name and location so a
copy of the report can be created to modify as a new custom report.

1. Open the Lucity module where the Request Summary Report is located.

o Select Work>>Request from the Lucity main menu.

2. Open the Reports dialog. Click the report icon on the module toolbar.
Locate the report to be modified and highlight it.
Summary of Requests

4. You’ll see the Report File Path at the bottom of the dialog box. This path tells you important
information about the report.

o The first part of the path tells you where the report file is located. In our example
below, the report is located at C:\Lucity76\Reports\Work\.

Note: Lucity report files are stored in the shared files location designated during your initial
installation. This is typically on a file server but could be on your local machine. In the
path shown below, C is a mapped drive. This could also be a UNC path using the full server
name.

o The report name appears after the last backslash. As you can see below, this report is
named ReqSum.rpt.

(%) Dialog (=(=®] = |
Reports:
Report Filker
5 Request Problem Count Report - & Th
[ Request Responze Time by Supervisor * This Record Only
= Request Responze Timme by Supervisar Summary " Curent Filter
[ Request ‘Waork Order Cozstz Grouped by Problem Type &l Becords
5 Requested "Work Form =5
5 Requeastz For Same Location _
5 Requests per Address Report View Report |
[+ Requests Without Affected il E Frint Pepart |
5 Responze Letter
Summary of Requests Export Fiepart |
5 Work RequestSefork Order Beview _u
= Ald |
Report Description:
: it |
One Line Surmmary of Each Request. -
Delete |
> Properties |
Report File Path:
IE:HLucity?EHH eportsiwiork AR egSum. rpt Cloze |
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In the report location, the Reports Directory can be sorted by Name or Date Modified by clicking on
the title in the upper bar.

Mame - | Date Modified |
WOTskSumBywCrew, rpt 1/22/2007 1:25 PM

Finding the Report Location and Name - Web

The Web Report list varies depending on the version of Lucity being used. Typically, there will be the
Report Name, Description and File Name. There may also be a reference to Quick Report Type and
Group Name.

Water A Manage Report Groups

Quick Report ~ Report Name Y  Report Description
/ Aging Work Crder Report Lists work orders, age, and key data for work orders that have
File Name T CQuick Report Type T Group Name
Reports\Work\WOsAgingWeb.rpt All Records Water
Renaming Reports

If you modify a standard report and save it under the original name, the changes you made will be
overridden the next time Lucity is upgraded. Thus, reports that are modified must be saved under a
new name in order to be used.

Note: You must have adequate permissions to save the modified reports. If you are not sure
whether you have these permissions, check with your system administrator.

1. You’ll want to make a copy of the report before you begin working on it. You can do this by
simply exporting the report from the Lucity module’s Report List to the Report Directory under
a different name.

2. It’s a good practice to establish a naming convention for your custom reports that makes them
easy to distinguish from the Lucity standard report names. For example, you might want to
add a two or three letter abbreviation for your company or organization or perhaps your initials
to the original report name as a prefix or suffix.

e Some sample custom report names are LC_ReqSum.rpt or ReqSum_LC.rpt.

e Adding the abbreviation to the end of the report name (before the .rpt extension)
will allow the custom report to be sorted with the original.

e Adding the abbreviation as a prefix will sort all your custom reports together.

3. Lucity reports store database connection information. When the report is run in Lucity, the
program replaces this connection information with connection strings specific to the
customer’s database configuration during run-time. When you export a report, the database
connection information used at run-time is saved. This is the preferred method for handling
Lucity reports and will ensure that the report stays pointed to the correct data set so that the
report can be run out in Crystal.

Beginning Crystal 1 9



Exporting a Report

As previously mentioned, the preferred way of handling Lucity reports is to export them. This allows
you to rename the report and make modifications as well as maintain your database connection
information. Follow the steps below to export a report:

Desktop
1. Within the Reports dialog click All Records.

2. Highlight the report you’d like to copy (Summary of Requests) and select Export Report.

(Wait)
(%) Dialog =lE] % |
Reports;
Repaort Filter
[ Request Problem Count Repaort - o
[ Request Rezponze Time by Supervisor Uit izaers Uity
[ Request Rezponze Time by Supervisor Summary " Current Filter
[ Request Work Order Costs Grouped by Problem Type & Al Becards
[s32 Requested Wk Formn r
[ Requests For Same Location :
[s32 Requests per Address Report Yiew Report |
5 Requests Without &ffected Lty E Frint Repart
[ Rezponse Letter

Export Repaort

B

Summary of Beguests

[ Wiork Requestiwork. Order Feview 8

= Add |
Report Description:
: Edi |
One Ling Summary of Each Fequest. -
Delete |
- Properties |
Repart File Path:
C:ALucity7E5R eportsiiwork s B eqS um. pt Cloze |

3. An Export dialog will appear.
a. Select “Crystal Reports” from the Format drop down box.
b. Then, select “Disk file” in the Destination drop down box.
c. Click OK.

Bport x|

Fotrnak:

IE Cryskal Reports (RPT)

Destination: Zancel

L]

L«

|= Disk file

Beginning Crystal 1 10



4. The following dialog will appear:

Organize = Mew folder == - I@
* MName Date modified Type
4 o Libraries
2TestWOSumMame.rpt 1041872011 3:05 PM  Crystal Report
» @ Documents o o
J’ . ActivityGuideline.rpt 5/31/201110:32 AM  Crystal Report
> usic
] Pict ActivityGuidelinePB.rpt 5/31/2011 10:32 AM  Crystal Report
> ictures
i - BudgetAnnWkPlanDet.rpt 5/31/2011 10:32 AM  Crystal Report
» ideos
BudgetDeptDetail.rpt 1/18/2012 1:37 PM Crystal Report
BudgetDeptList.rpt 5/31/2011 10:33 AM  Crystal Report

a8 Com puter

; BudgetDeptSumm.rpt 5/31/2011 13:33 AM Crystal Report
» &, Local Disk (C3)
BudgetPlannedVsActual.rpt 5/8/2012 8:55 AM Crystal Report ~
s HP_TOOLS (B) | -, | o | F
File name: LC_RegSum.rpt -
Save as type: ’Cl}rstal Report (*.rpt) vl
@ Hide Folders save | | Cancel |

5. Find the location where the report is to be stored. It is recommended that you use the default
report location discussed in the previous pages.

6. Type in a new File Name (LC_ReqSum.rpt).
7. Click Save.

8. At this point the report needs to run, the subtitle query is optional but almost any other query
such as dates must be entered, then click OK.

' Note: If the Export takes more than a few seconds then cancel and change the Report filter
' to “This Record Only”. This may be necessary for complex reports, especially ones with
‘ subreports. Then Export (follow above steps 2 - 8).

Exporting Records o et
| |

Records | | | |
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9. Close the Report dialog.
10. Minimize the Lucity module.
11. In the Reports Directory, open the new report that was just exported.
o On the report title either Right click and select Open or double click.
12. From the menu bar at the top of the screen, select File.
13. Uncheck the Save Data with Report option.
14. Click Save.

15. If the report is Exported with This Record Only then the Select Expert needs to be opened and
the ID selection formula deleted.

a. Click Select Expert ‘f?'.

b. Click Show Formula>>>.

em - mmee = o = - — — '“‘““""""‘—‘I—“—“"—r_
Select Expert p—— .- B
WKREQ.RQ_ID | <MNew =
is equal to ~| 57.00 o| L e, )
] [ Delete ]
b
[ Browse... ]
Ok, ] [ Cancel ] [ Help 4 Show Farmula == >
—
Select Expert N —p— .- B |i
WKREQ.RQ_ID | <MNew:= |
[is equal to "] S7.00 - [ — ]
[ Delete ]
[ Browse... ]
[ Ok ] [ Cancel ] [ Help [ Hide Formula < << ]
(@ Record Selection (7 Group Selection [ Formula Editar. .. ]
*

c. Click and drag over the formula.

d. Press Delete key to remove.

Beginning Crystal 1 12




e. Click OK.
f. Click Save.
You are now ready to begin making modifications to the report.

Note: Reports with “secure” fields may show as “Hidden” but this is temporary and can be
changed when refreshing the report and choosing the “Prompt for new parameter values”.
If date fields were required to run the report these too would be temporarily placed in the
report until the report is refreshed and new parameters are given.

Example 1

Web

In the Request module highlight one record.
In the Report Dialog click on the report to be Exported. (Requests per Address Report)
Run the report with Selected Records and the Advanced View (HTML) options.

Once the report has run, select the Export this report option in the top tool bar.

ook W=

This opens the following Dialog. Click Export.
File Format:
Crystal Reports (RPT) -
Page Range:
(@) All Pages
() Select Pages

From :| | To :| |

6. Open the exported file from the Browser's download.
Chrome drops a box in the bottom left of the page. (lucityMSCRYV)
Click to open.

Ev I ucityMSCRV {10).rpt o

7. Click through any comments such as Invalid Printer or Crystal Reports version.

8. In the tool bar select File, UNCHECK the Save Data with Report option.

9. Open the Select Expert and remove the formula for the ID field that was placed in there
because the report was run with Selected Records.

10. In the top tool bar select File > Save as...
11. Browse to the location for this new custom report (client specific - in training we will use
CustomLucityWebReports) and give it a new file name (LC_ReqPerAddyWeb.rpt)

You now have a copy of the report with a new name and pointed to your data. The User ID and
Password for your database are required to run the report away from the Lucity environment. Ex. 2

Beginning Crystal 1 13



Setup Options

Whether a report is modified or created new, it is helpful for certain report options to be set before
working on the report. Within the Crystal Reports Options and Report Options there are a number of

settings that can be preset for generalizations. These can be changed for individual reports or
individual fields within a report.

Options

To view the “Options” section, we will look at the previously exported report, LC_ReqSum.rpt.

The following screen captures show what options can be changed behind the scenes. These options will

In the Menu Bar click File >> Options

be reflected in all of the reports created.

-

sz

Short Section Mames
Show Hidden Sections

(Grid options:
[T 5nap To Grid
Free-Form Placement
Gnd Size:

0083 in

Field options:
[¥] Show Field Mames

[] Insert Detail Field Headings
Insert Group Mame with Group

Options

| Fonts | Smart Tag & HTML Preview Dependency Checher
Layout | Database Formula Editor Reporting I Fields
Design View Preview
Rulers Rulers
[ Guidelines [ Guidelines
(] Grid 7] Grid
Tool Tips Tool Tips

Section Names
Page Breaks in Wide Pages

Pages Start With:
i@ Full Size (100 %)
() Fit Width
i) Fit Page

Display Group Tree

OK || Cancel || Hebp

Beginning Crystal 1
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j -

Options
Fonts I Smart Tag & HTML Preview Dependency Checker
Layout | Databass Formula Editor Reparting I Fields

Tables and Fields
(@ Show Name
™) Show Description

() Show Bath

| Data Explorer

Tables

Views

[] System Tables
Synoryms

[] Stored Procedures

Advanced Options

IUse Indexes or Server for Speed
[] Perform Grouping On Server

[7] Perform Queny Asynchronoushy
Werify On First Refresh

[ Automatic Smart Linking

Database Server is Case-Insensitive
Select Distinct Data for Browsing

[ Verify Stored Procedures On First Refresh
Yerify When Database Driver Upgraded

Sort Tables Alphabetically

Sort Fields Alphabetically

Table name LIKE:

(%)
Owner LIKE:

(%)

OK || cancel || Hei

Once the database has been unified it is important to confirm the “Stored Procedures” option is

unchecked. This is necessary to show all the Lucity tables to add to a report or when repointing tables.
Crystal Reports limits the number of objects available to be used in a report and Stored Procedures are
counted as objects but are typically not used in reporting.

Notes:

Beginning Crystal 1
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- Options u

Forts | Smart Tag & HTML Preview I Dependency Checker

Layout | Database Formula Editor | Reporting | Fields
| Text Options
Font: Tab Size:
Courier New v 10 ~ 4
Calar
Element: Foreground:
Comment Black
ord
Text Selection Background:
White

Use Windows system color

Default Formula Language:

|Crystal Synta -

Mull Treatment : UFL Support:

| Exceptions For Nulls - C/COM UFLs Only -
Sample:

FfL formula that returns a String wvalue
If {Orders.0rder Ampunt} >= 1000 Then

"Insured shipping”

Notes:

Beginning Crystal 1



. Options u

Forts | Smart Tag & HTML Preview I Dependency Checker
Layout | Database | Formula Editar | Reporting | Fields
Enterprise Settings

|Update Enterprise Report Properties on Save
[] Update Connected Repository Objects on Open

Reading Data
[ Convert Database MULL Values to Default
[] Convert Other MULL Values to Default
[7] Mways Sort Locally

[7] 5ave Data With Report

[] Discard Saved Data on Open

[ Re-import Subreport on Open

[] Suppress Printing f Mo Records Selected

[] Show All Headers on Drill Down

[7] Autosave Reports After 5 Minutes
Display Alertts on Refresh

[] Save Preview Picture

[T Retain Original Image Color Depth

erticns u

Forts | Smart Tag & HTML Preview Dependency Checher |
Layout | Database | Fomula Editor Reporting | Fields

Field farmat

Date...

Time...

Date and Time...

Boolean ...

|
|
|
|
|
|
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For each field type there are format options specific to that type. There is a sample box at the bottom
of the Format Editor for each field type that shows the current field formatting.

String
r Format Editor | PG |

Common | Barder |Hyperlir1k

Cibject Mame:

[ read-only [ Lock Position and Size
D Suppress
[ Suppress If Duplicated

[l can Grow Mazirurm number of lines:
(Enter 0 for no limit) 0

Text Rotation: degrees

Haorizontal Alignment: [Deﬁ:ult v]

X
L)

C55 Class Name: 2
Repeat on Horizontal Pages

Keep Object Together

Close Border on Page Break

Sample:

P

Number

Commen | Number | Border | Hyperlink

Style

Systemn Default Mumber Format
-1123

-1,123

-1123.00

-1,123.00 [ Display Currency Symbal
-1123.0000 _
-1,123.0000 Fined
(1123)
(1,123)
{1123.00)
(1,123.00)
(1123.0000)

E 1! lZS.UUUUi

Currency symbal (system default):

(@ Floating

Beginning Crystal 1 18



Currency

Common | Number | Barder | Hyperlink

£-1123.0000
£-1,123.0000
§(1123)
5(1,123)
$(1123.00)
£(1,123.00)
£(1123.0000)
€(1,123.0000)

.

Date

Common | Date |Border|Hyper|jnk|

Currency symbol {(system default):

Display Currency Symbal
i) Fixed

@) Floating

Style

31

3jo1

3f1/99

03/01/1999

1-Mar

1-Mar-99

1-Mar-1999
01-4Mar-1999
01-March-1959

Mar-99

March 1999

March 01, 1999
Maonday, March 1, 1999
Monday, 1 March, 1999
3

3-89

Sﬁstem Default LunE Format

Customize...

Beginning Crystal 1
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Time

Commaon | TiMe |Border|HyperIink

Style

System Default Time
1323

1:23 pm

13:23:45

1:23:45 pm
13:23.45

| customize... |

Boolean

Commen | Boolean |Border I Hyperlink

Boolean Text: [True or False

Beginning Crystal 1
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erticns u1

| Layout I Database Fomula Editor Reporting | Fields
Forts | Smart Tag & HTML Preview Dependency Checker
| Default forts: N
| Fields... |
[ Summary Fields... ]

[ Group Mame Fields... ]

[ Test Objects. |

Field Titles... |

Charts... ]

Each Field or Object type opens the Font options.

-

T Aral Black talic i)
T Aral COP L | Bold 1 E|
T Adal Mamow Bold lalic 12
T Aral Rounded MT Bold 14
T Aral Unicode MS 16
T Baskerville Old Face 7 | |18 -
Caolor:

B cacx -
Effect:

[ Strikeout [] Underline
Preview:

AaBbYyiz

This iz a True Type font.
This same fort will be used on both your printer and your screen.

Beginning Crystal 1

21



erﬁons u"

Layout | Database I Formula Editor I Feporting | Fields
. | Smart Tag & HTML Preview | Dependency Checker

[l Smart Tag Web Server Options i\

Web Server Name:
Virtual Directory: crystalreportviewers11
Viewing Page: cremarttag asp

HTML Preview Options

HTML Preview is always enabled when you are logged on to the
BusinessObjects Enterprise

F Enable HTML Preview when not logged on to the BusinessObjects

Enterprise
Web Server Name: localhost
Platfarm: @ CoM
Java
et
URL http:# Aocalhost /crystalreportviewers 11 /preview.
RAS Server Name: localhost

erticns u1

Layout | Database | Fomula Editor I Repaorting I Fields |
Forts | Smart Tag & HTML Preview |  Dependency Checker

I Report Checking Options i

Compile formulas

Compile 5GL expressions
Compile custom functions
Validate hyperink URLs
Verify database

Multi-Repaort Checking Options

Check repositary custom functions

Check repository objects et and bitmap)
Check report part hyperinks

Check subreports which are redimported on open
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Report Options

Report Options are specific to an individual report.

o In the Menu Bar click File >> Report Options.

These Report Options are also available within Subreports (discussed later).

| Report Options
General Settings

Convert Database MULL Values to Default
[ ]cConvert Other NULL Values to Default
[ ]show All Headers On Drill Down
[ ] Always Sort Locally
Database Server is Case-Insensitive
Perform Grouping On Server
IUse Indexes Or Server For Speed
Verify on First Refresh
[ ]verify Stored Procedures on First Refresh
|:| Respect Keep Group Together On First Page
] save Lock Report Design

Initial Report Part Settings
Paste the Report Part link:

[ ]5ave Data With Report

[ ]suppress Frinting If Mo Records
Perform Query Asynchronously
Show Preview Panel

Display Alerts on Refresh

[ ]read-only

[ ]select Distinct Records

Select Distinct Data for Browsing
[ ]retain Original Image Color Depth

Prompt For Hyperlinks

Legacy XML Expert...

Object Mame: |

Data Context: |

Preview Pages Start With Full Size

Beginning Crystal 1
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Document Properties

Another useful Crystal option is Document Properties. This information could help in report
documentation. Some of the fields are available to be used in the report. They are found in the
Special Fields section listed in Field Explorer (Discussed later).

o In the Menu Bar click File >> Summary Info...

" Document ﬁmﬁa——ﬁ-
Summary | Statistics

Application: Crystal Reports

Authar:

Keywords:
Comments: i

Title:

Subject:

Template:
Save Preview Picture

OK || Cancel || Hep |
Docurment Properties | 2 |
' Statistics
Last Saved By:
Revision number: 53
Tatal Editing Time: £33 min
Last Printed:
Created: 9/14/2004 3.45:02 PM
Last Saved: 10/18/2011 3:05:37 PM
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Report Sections

Every report has a minimum of five sections. These sections show on the left side of the report.

LC_ReqSum.rpt =
Design |

B

Reoort Header
Page Header

Details
Report Footer

Page Foater

To conserve space this section can be reduced in size by right clicking in the section and selecting Show
Short Section Names

Page Footer

Suppress (Mo Dril-Down)

Section Expert...

—
¢  Show Short Section Mames >

Insert Line
Delete Last Line
Arrange Lines
Fit: Section

Insert Section Below

Select Al Section Objects

LC_ReqSum.rpt x L

Design |
U L |
RH N e
PH
- Summan
. b.F'F-tep»t]rtSuIJ-t
'__ Request#
D = RQ_NUMBER
RF
PF
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Modifying a Report
Beneath the toolbars the open report will have a tab with either the report file name or the Title set
up in Document Properties. Beneath this, the exported report already has two tabs available, Design

and Preview. If the report is opened from the report folder then the Design tab will be present, but
the Preview tab will only show after the report has been run.

File Edit View Insert Format ‘Qambase gepurt Window
Dw -HISRA&I'EBS - «-|EE
‘ab B E s MRS
eE|r2&F @R Bas g
/ LC_ReqSum.rpt X |

Design  Preview x|

II PH

The Design page is where most of the report modifications will take place but can be done in Preview
as well.

KD - (3 o
Note: The undo and redo buttons are very helpful when revising reports. |

Saving and Viewing your Report

e Save any changes by clicking on Save =l . Itis a good idea to Save while you are working and
not just when you are finished with the report. (You never know when you will encounter one
of those mysterious error statements that shuts down your system, losing all of your work).

[&

e To preview the report, click Print Preview .
-
e To refresh the report, click Refresh = |

Preview Sample
e To limit the number of records previewed:

o In the Menu Bar click View.
o Select Preview Sample...

o Select First and type in the number of records you would like the report to run with.
This is particularly helpful when you have large numbers of records to deal with.
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Preview Sample ﬁ

Preview this report with:
1 Al records.
i@ First fioo records.
| oK || Camcel || Hebp

Set Print Date

Sometimes reports use the PrintDate function in formulas. This is just as it sounds, it uses the current
date. If you need to try the report on a previous date that is known to meet certain criteria on that
date, then the Printdate can be set to a specific date.

o In the Menu Bar click Report.
o Select Set Print Date and Time...
o Select Other

o Fill out the desired Date and Time

Set Print Date and Time ﬂ
e
() Today's Date and Time
Date:
1f 1/2017 @~
Tirme:
2:57 PM =

Note: The Find Tool button ] can be used in both the Design and Preview tabs and is
helpful for locating specific fields or records.

Field Types

Field types include Text Objects, Database Fields, Formula Fields, Field Titles, Parameter Fields,
Running Total Fields, Group Name Fields and Special Fields.

When the cursor is placed over the field boxes, field type information appears if Tooltips is turned on.

e |f you place the cursor over the Request # box, Text Object appears. This means that Request
# is a group of characters that can be modified. This is a column header that was manually
typed in.

e If the cursor is placed over RQ_Number, it shows the table (WKREQ), field name (RQ_NUMBER)
and data type (string). Depending on the age of the report the default field caption may also
show. This Database Field is bringing in data from a table. In Field Explorer (discussed later)
the previous tooltip information may show for the field and if the "Show Field Type" option is
turned on then the field mask and size will show as well.
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Changing Text in Text Objects

In the example report, LC_ReqSum.rpt, we will change the text object field “Request #” to “Request
Number”.

To change the text within a Text Object:
1. Double click on the box with Request #.
2. Click and drag over the portion you want to change (#).

3. Type the new text (Number) and click out of the box.
F

Tr 4

EE-que&t# . [Record Date :I:lequestNumb-El

RQ_NUMBER . @RegDate
)

1T q
. [Fecord Date,

RQ_MNUMBER .. @ReqDate

change to

Field Sizing
Sometimes it is necessary to resize or delete existing fields to accommodate additional text or make
room for a new field.

Resize a Text Box:

1. Click on the text object (Problem) which will highlight the borders of the box.

e This will activate the sizing handles, the small dark dots on each side of the box.
i"rnblem : :'

2. Place the cursor over the right border’s mark which will turn the curser into a two
sided arrow. Click and drag the box to the left to reduce the empty space.

r = 1
Fro bl_e m

Resize a Field:
1. Click on the field (RQ_PROB_TY).

2. Click on the right sizing handle and drag to the left (to about 7.5” in the top ruler).

Deleting a Field

1. Click on the field (RQ_PRTY_TY) to highlight it.
2. Press the Delete key
OR

Right click in the field and select Delete

Field Movement

1. The simplest form of moving fields is by clicking on the field and dragging it to the new

location.

a. Click on the Priority text object (resize to reduce the empty space).

b. Drag to the right until the left edge is aligned with the 5” mark.
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2. Multiple fields can be moved by holding the shift key down while clicking on the fields. This
will highlight the fields which can then be moved or sized or formatted all at the same time.

The click and drag feature, as well as the adjustment of the box size, are done to the
highlighted box with the four dark marks on the edges (anchor box). Multiple fields may be
copied or cut as a unit as well.

3. Multiple aligned fields can be moved as a unit by “attaching” Guidelines to the fields. This can
be done both horizontally and vertically using the rulers at the top and left side of the report
(if this option is turned on).

a. In the top ruler, click near the 6” mark and hold, moving slightly if necessary, until the
dotted line meets the left side of the Problem text box. Release

= The left side of the text box will appear red and there is a pointed box in the
ruler section.

b. The left edge of the RQ_PROB_TY field will likely be red as well but if not, click on the
field and drag to attach the left side to the guideline.

- B B A
e o

e
+ Froblem

RQ_FROB_TY

c. To move the fields attached to the guideline, click on the ruler marker and drag it to
the new location. (about 6 5/8”) This will move any fields attached to the guideline.

Note: Caution should be used with guidelines if there are a number of fields in the
report. You may attach fields you had no intention of moving. This is a problem that
can affect Lucity Detail reports.

d. Toremove a marker, click on it and drag it up and away from the ruler. Then, release
your mouse.

e. All markers can be removed with a right click in the ruler or body of the report and
then selecting either Remove All Vertical Guidelines and/or Remove All Horizontal
Guidelines.

Section Expert...
Show Hidden Sections in Dasign

Insert Text Object
Insert Cross-Tah...
Insert Chart...

EBoS (<]

Remove All Vertical Guidelines
Remove All Horizontal Guidelines
Fage Setup...

Snap to Grid

R Paste

Example 3
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Add a Text Object

Make sure there is room to add the text object.
In the example we will create space between the Status Date and Priority:

1. Reduce the size of the Status text object to close up the empty space.

2. Reduce the RQ_STAT_TY field (right edge to 3 1/4”).

3. Move the Status Date text object and @StatDate field to the left (right edge 4 1/8”).
This has opened up space to add a new text object.

4. Click (release - don’t drag) on Insert Text Object “* . The cursor turns into a plus sign.

5. Click on the location where the box is to be inserted. Just to the right of the Status Date text
object.

6. Type in the desired text (Follow-Up).
7. Click out of the box when you are finished.

8. Resize to close the empty space. In the example it is overlapping the Priority text object. It
doesn’t hurt anything but may hinder your design efforts later.

r B .i: A A
. Status Datg F ollow-Up J Pricrity |

Adding Fields

To add a field, you may need to make room by moving or removing existing fields.
1. In our example, we’ll change the “Priority” column to “Category”.
o First, you’ll edit the Priority column header to read Category.
e The RQ_PRTY_TY field has already been deleted.
2. Now, you’ll add the new “Category” field.

3. You’ll need to find out the name of the “Category” text field.

Desktop
a. Go back to the Requests module and locate the field that is to be shown in the report.
b. With your cursor in the field, press Ctrl and then right click.
c. Select Field Definition.

e Some fields, including the Code field, have an additional option, Field Properties.
This option offers additional information such as the field Mask and Editing options.

e In the example, you can see that the table name is WKREQ and the “Category”
field name is RQ_CAT_TY.

" Field Definition ==

Captior |Category Text
Field Mame: |RE_CAT_TY
Table Mame: [wKREQD

Definition Lack: [

Lucity Dref I Cloze

[The Category figld is & code-description, pick list field -~
that allows pou to select a categomy for the request.
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Note: Sometimes fields that have a code box and a text box will only show the field
definition of the code portion. The only difference with the text portion is that the field
name would end in TY rather than CD.

Sometimes if the box is pulling information from a different module, the field definition will
not show up or the given field name may not be accurate. It may be a connecting field to
pull the correct data from another table.

Web

a. Go into the Request Form and open the Field Property Modification Tool button. Elo

b. Scroll to "Category Text" and select. This will open a window with the field information.
Caption

WKREQ - RQ_CAT_TY
Property Name: CategoryType
Form Caption:
Current Caption: Category Text
User Defined Caption:
Lucity Caption: Category Text

c. As of version 18r2 there is a new option for obtaining field information. In the form, click

on the Field Property Information tool button. 'ﬂ?} (looks like the Admin Portal button)

d. This will activate a new feature. This same symbol now shows in front of each field. Click
on the one next to the field (Category).

Category *
=
PMMG4

e. This opens a Component Information window.

Storm WQ Management Plan

Compenent information g Component Information ¢

CategoryCode CategoryCode
Category Category

Label Current Caption

Cat Category

atego
o Field Name

Field Name WoLGAT_CD

RQ_CAT_CD Table Name
Table Name WKORDER

WEREQ Lucity Caption

Default Caption

Category
Global Caption

Category
Mask Mask
10x 10%
V18r2. V19
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4. Return to the report. Then, complete the following steps to add the new field.

a. Open Field Explorer. ——_ (Also, under “View” in the top menu bar.) This may already
be open in the report.

b. Open Database Fields (click on the + sign).

Field Explorer o x

= k@ Database Fields
- WKREQ
WKREQNOT
[#-[E WKREQSTR
[+-%1 Formula Fields

S0L Expression Fields
[+-[?] Parameter Fields
EEI---E Running Total Fields
E Group Mame Fields
-4 Special Fields

c. Open the WKREQ table (click on the + sign).

Field Explorer o x
EIE Database Fields -
-] WKREQ
@@ RG_ACCOUNT
-m3 RQ_ADESC1

d. Click and drag the RQ_CAT_TY field and place it in the Detail section under the
Category column heading. Add a marker in the ruler section.

In
a

5. We will now add the X and Y Coordinate fields:
a. Change the Address text object to X Coord.

o

Reduce the box width to close up the space.
Add another text object called Y Coord to the right of the X Coord.
Right align both the X and Y Coord text objects.

Delete the @Location (address formula) field.

-~ 0o a o

Add the appropriate fields below the X and Y column headers.

- 4 r 4
¥ Coord, Y Coord

L

T T T T
% _COORD, ¥_COORD,
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Special Fields

There are a number of “Special Fields” that Crystal Reports provides. In Field Explorer expand Special
Fields.

Field Explorer o x

[~ E# Database Fields

[#-X%1 Formula Fields

-[&@l] 5QL Expression Fields

[#-[?] Parameter Fields

E Running Total Fields

-2 Group Name Fields

=% Spedal Fields

..... = Content Locale

..... 0= Current CE User ID

----- = Current CE User Mame

----- == Current CE User Time Zone

----- = Data Date

----- = Data Time

----- = Data Time Zone

----- = File Author <+———
..... £= File Creation Date

----- £= File Path and Mame

----- &= Group Mumber

----- == Group Selection Formula

----- == Horizontal Page Mumber

----- == Modification Date

----- == Modification Time

..... == Page N of M

----- ==} Page Mumber

----- &= Print Date

----- &= Print Time

----- == Print Time Zone

----- 2= Record Mumber

----- &= Record Selection Formula

----- e= Report Comments <————
----- &= Report Title +t—
----- e= Total Page Count

The report is currently using Page Number, Print Date and Print Time. If the Summary Info... (from
File in the toolbar) had been filled out for the report then several of these fields would have been
available to bring into the report (File Author, Report Comments and Report Title).

The File Path and Name could be a helpful field to place in the Report Footer. This would tell you
exactly where the report is located and the exact report name (LC_ReqSum.rpt).
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Copying Fields

A field that is used in a report can be copied and used elsewhere in the report. There are various
methods for doing this.

o Click on the field(s) and:
» Right click Copy and then right click Paste in the new location.
» Ctrl C to copy then Ctrl V to paste in the new location.

» For a single field - hold Ctrl, click and drag to new location and release.

Formatting Fields

General Formatting

If you want a field to stand out, there are various tools you can use. You can change the size, font or
color of the text as well as change it to boldface, italics, or underline. The options are in the
Formatting Toolbar (pictured below).

[ Arial e -4 & B US|

Formatting can also be accessed by right clicking on the box and selecting Format Text... (For a text
object) or Format Field... (For a field with data).

A-H-=808

o Click on the box containing the text you wish to change. Then, select the options to be used.

o If partial text is to be changed, double click on the box and then click and drag over the part
that is to be changed.

Note: For Web reports avoid the use of the Calibri font. There are issues with viewing the
report as PDF.

In the example report change the column header text objects to be Bold.
1. Hold the shift key down and click on all boxes that need changing.
2. Click on the B (for bold) in the toolbar.
3. Resize any boxes to accommodate the bold text.

Preview the report.

Request # Record Date 5tatus Status Date Follow-Up Category Problem X Coord Y Coord

2006-00012 4/5/2006 Completed 8/12/2008 Commercial Collection INFC REQUEST - 43.64 -116.24
COMMERCIAL

The X and Y coordinates are showing with two digits to the right of the decimal and the actual values in
the record require 8 digits.

LocxCoord. ||| 4363871944
Loc Coord. ||| 11624135134

Number Formatting

Number fields may require formatting for many reasons such as decimals, rounding, negatives, field
size where the value is showing ##### or the numbers are cut off. The field size can either be
increased, or the field can be reformatted to remove the decimals.
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To change the format of the RQ_X_COORD field:
1. Right click on the field and select Format Field....

Field: WKREQ.RQ_X_COORD

(,@ Format Field... S
Format Fainter

2 Highlighting Expert...

B Browse Field Data...
&' selact Expert...

Insert
Mowve

Size and Position...

¥ cut
Copy
R Paste

Delete

2. Click on Customize...

Format Editor

Style

| common | Border | Fant | Number | Hyperlink |

0l o|1123
-1,123
-1123.00
-1,123.00
-1123,0000

(1123,0000)

System Default Number Format

E 1! 123.0000;

Csamae_D

Sample:

Currency symbol (system default):

[ "] Digplay Currency Symbaol
Fixed

(@ Floating
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3. Click on the down arrow next to “Decimals:” and select the correct option for the number of
digits.

4. Repeat for “Rounding”.

Custom Style ﬁ
Cun'enw Smbo| Mumber

[] Use Accourting Format

[ Suppress ff Zerm 2| Decimal Separator: . X2

fl | Decimals: — Thousands Separator: B2
Rounding: X2 Symbal: ]

Megatives: 123 v | %2 [¥] Leading Zero x2

Show Zero Val :
[] Reverse Sign for Display 2 oW LEMD Values a3
[] Allow Field Clipping X2 <Defautt Format: -
Sample:

-55, 555 BERREEEG

5. Select OK to close the Custom Style dialog.
6. Select OK to close the Format Editor dialog.

In the preview tab the X Coordinate value is now showing:

7. Increase the field size with the sizing handles on the field.

Another issue that sometimes occurs is the clipping of numbers. This is where you see incomplete
numbers instead of the ###.##. This is not recommended. This option is in the Custom Style dialog
box.

[] Allow Field Clipping

Make sure the “Allow Field Clipping” box is NOT checked. This is honored in Crystal and Desktop but
Web Basic View will continue to clip and Advanced View will grow to accommodate the number,
overlapping the next field if necessary.
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Copying Formatting

The Y Coordinate will need similar formatting. The Format Painter can be used to copy the X
Coordinate formatting onto the Y Coordinate field as follows:

1. Click on the RQ_X_COORD field.

2. Select the Format Painter in the Standard Toolbar <t
Click on the RQ_Y_COORD field.

4. Increase the field size to accommodate the additional digits.

X Coord ¥ Coord

43.64000000 -116.24000000

Note: Many cost fields within Work reports are fields that will be “Hidden” if the person
running the report does not have the proper security. The way this is achieved turns the
number field into a “Text” type field thus normal “number” formatting does not work on
these fields.

Example 4

Alignment of Fields
1. Shift click on all fields to be aligned.
OR - use a lasso. Click hold and drag to form a box around fields to highlight.

2. Right click on the field you want to size and align with; the darker markers will show up on the
field you select.

To size, click Size > Same Height.
4. To align, repeat step 2, clicking Align > Tops (or Bottoms, see what looks better).
Do this for both the Column Headers and fields in the Detail section.

Note: If a section has only a single line of fields, then all fields can be selected by right
clicking in the left margin of the section and selecting “Select All Section Objects”. This
option isn't available in our example due to the line in the Detail section. You may Ctrl click
on the line to "unselect” it, then the align option will be available.

Example 5

Using Formulas

Crystal provides a way to create formulas that can be used in record selection, conditional formatting,
conditional suppression and calculations to name a few.

Date and Time Fields

In Lucity the date and time fields are a DateTime type field. If the Date field is brought in directly
with the Options (File > Options > Fields > Date and Time... > Date and Time) set as System Default
Short Format, the date field when brought directly into the report will look like this:

2/20/2014 120000AM - The time portion is not a good value.

In the same way the Time field will look like this:

111900 12:01:00FM The date portion is not a good value.

Beginning Crystal 1 37



In File > Options > Fields > Field format the Date and Time type field could be set up to always show a
date (without time) but then the time field would also show as a date.

Each field’s format can be set case by case to either show the date or time portion but the best
practice is to handle the DateTime fields with a formula. The formula will take out the required
portion of the field and use the default formatting.

r 4
Note: Formula fields begin with the @ symbol like the Status Date - @=tstDats

Date Fields
In our example, we will add the Follow-Up Date.

1. Within Field Explorer, right click on Formula Fields.
2. Select New.

3. Type in the name. For our example, we’ve entered “FollowUpDt”.

Mame: FollowUpCt|

| ok || cance |

4. OK
This will open the Formula Workshop.
"B Formula Workshop - Formula Editor - FollowlpDt . ESSEoN <N
| & Save and close [ save | o -® e 52 | % x |2 @ |% &
|20 o |G e % % % |8 |FE[EE)|cysa Sytax ~ || [Bxcsptions For huis ~|| 4
[ Report Custom Functions - fll % (E{Eiﬁof;;z{oggc{m fll @ @yfunctons fll 9 Operon

-- EB¢ Repository Custom Functions
=1 Formula Fields

@7 Selection Formulas
[-{_7] Formatting Formulas I -

It would be helpful to have the Hide/Show workshop tree highlighted | as well as the Field

Tree, Function Tree and Operator Tree
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Expand the Function Tree, Click the plus sign (+) in front of Functions.
Expand Date and Time.

Expand Date.

O N o uv

Double click the Date(dateTime) option.

EI--@- Functions

- [l Math

@- Summary

@- Financial

@- Strings
L—__I@ Date and Time

- Cument Date

- Cument Time
- Cument Date Time
=)~ Date

CLate (date Time)
Lo Date (YY1, MM, DD}

9. The following formula will show up in the lower box work space of the Formula
Workshop:

Date d:l

10. In the Field Tree expand the database.
11. Expand the WKREQ table.

12. Make sure the cursor is flashing between the Date parentheses in the formula box, then
in the Field Tree double click RQ_FLLW_DT. The final formula will look like this:

Date ({WKREQ.RQ FLLW DT})
13. Click Save and close.

The new formula will now show under the Formula Fields in Field Explorer.

Field Explorer qx

= =l W VI o
[ Database Fields
=-X4 Formula Fields

14. Drag the new formula field into the Detail section, under the Follow-Up column
header.

Follow—U p 1

- T
@ Follow-UpDtk
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Time Fields

A Time field which is also a DateTime type of field should also be set up in a formula. It would

be created like the date formula except in the Formula Workshop in the Functions Tree the
Time option would be used to create the formula.

EI--[E- Functions
- (gl Math
@- Summary
@- Financial
@- Strings
Elﬁ- Date and Time
- CumentDate
- Cumrent Time
- CumentDate Time
[+ Date
[=- Time

‘. Time (HH, MM, 55)

Note: Once the date has been pulled from the DateTime field in the Date formula it will
follow the formatting in Options for Date. In a like way the Time formula will now format
as a Time field. This can be changed in a general way out in Options or specifically with the
right click Format Field... option.

Note: Formulas created in the Formula Workshop can be typed in without using any of the
“Tools”. The Tool Fields, Functions and Operators may also be dragged in as opposed to

double clicking.

Documentation Comments

Comments can be made within the Formula Workshop to help with documentation. The comments can
be in a separate formula documenting all the changes for the report or they can be specific comments
to a formula. Each line of a comment must be preceded by two forward slashes //. This will change
the font color within the formula (default green can be changed in File > Options > Formula Editor).

A general comment will be added to the example.

1
2
3.
4

Right click on Formula Fields and select New.

Type in “Comment”.

In the lower section, type //.

Next, type whatever clues you need to remember what was done. We'll type:
Removed Priority and Address. Added Follow-Up date, Category, and X & Y

Shows: //Removed Priority and Address. Added Follow-Up date, Category, and X & Y
Select Save and Close.

Drag the Comment formula to whichever section you will see it, like the Page Header. This will
not show up in the Preview mode of the report, but it is there for you to reference in the
future.

q

= =
= Comment - |

- A
Print Date

rirna

- S
Print Tim =

. X Coord, ¥ Coord

v
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Inserting Lines and Boxes

Lines

When reports have a great deal of information, it is often helpful to use lines to break up the data.
This makes it easier to read. They may be place vertically or horizontally.

1. Click on Insert Line = . This turns the cursor into a pencil.

2. Place the pencil point wherever you would like to insert the line in the report. Then, drag the
line across the screen until you have reached the desired length.

3. The line characteristics may be modified by right clicking on the line and selecting Format
Line.

e Several line samples appear below

4. If any of the fields above the line are set to grow, then in the Format Line dialog (right click on
the line) select “Move to Bottom of Section when Printing”.

Format Editor Iﬂ
Line
Border:
Style: [Single -
Width: =l = = = =| =| m| == (5pt
Calor: Silver -

/

-

< Move to Bottom of Section when Printing
~\

[7] Suppress ["] Repeat on Horizontal Pages

[] Read-only [ Lock Position and Size

This usually solves any growing issues, but sometimes the line should be given its own section instead.

o A new section can be added by right clicking in the left margin next to the section and
selecting Insert Section Below. These options can also be selected by typing the underlined
letter.

Insert Section Below

The “1” is underlined.
All Crystal sections allow multiples. They will show with a letter behind the section designation.
Example: Details a (Da), Details b (Db), Report Footer a (RFa), Report Footer b (RFb)...
Example 6
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Boxes

Another option is enclosing data in a box. In the example we will place a box around the Total
Requests text object and field (#TotReq) .

1.
2.

[o) SIS 1 B N 8]

Click on Insert Box . This turns the cursor into a pencil.

Place the pencil point wherever one corner of the box should be (top left of Total Requests
box) and then drag diagonally to the other corner (bottom right of #TotReq box) and click.

Right click on the box frame and select Format Box...
Select Fill:>>Color:

Use the drop-down arrow to select Yellow.

Click OK

.
Format Editor &

Box | Rounding

Border:
Style: [Single -

Width: =l = = =] =| m =] qp

Colar: - Black -

[] Drop Shadow

Fill:
Colar: Yellow -

Always Close Border

[] Extend to Bottom of Section when Printing

[ Suppress [| Repeat on Horizontal Pages
[] Read-only [] Lock Position and Size
| oK || Cancel || Hep

Total Requests: _#TotReq |

Example 7
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“Growing” Fields

Sometimes the data in a field is cut off and there is no more horizontal room to increase the field size.
In this case, it is helpful to allow the information to be shown in multiple lines. This can be done with
the “Can Grow” option.

To add or delete the “Can Grow” option, complete the following:
1. In the example, right click on the field (RQ_CAT_TY).
2. Select Format Field.
3. On the Common tab, check the Can Grow box.

e The “Maximum number of lines” should be “0” to see all the data in the field. This will
scroll the data vertically. If the Can Grow option is unchecked, then in most cases the
data will cut off when reaching the limits of the field size. This is not the case for the
Advanced View in the Web. The field will grow horizontally to the right and overlap any
field to the right. This can be corrected by using the Can Grow option with the
“Maximum number of lines” set at “1”.

Format Editor g

Comman |Eurder I Font | Paragraph I Hyperlink
Ohject Mame: ROQCATTY1
Tool Tip Text: w2
o
[ read-only [ Lock Position and Size
|:| Suppress >-SE:':-
! [ suppress If Duplicated X2 I
| Can Grow Maximumn number of lines: %2
(Enter 0 for na limit) 0
Text Rotation: degrees
Horizontal Alignment: [Default - ] ’.F::':.
Display String: 3_5:1:_
C55 Class Mame: ’_F::':.
|:| Repeat on Horizontal Pages
Keep Object Together x2
Close Border on Page Break ﬁ
Sample:
R S S S S S S S e S S e D K,

[ QK J[ Cancel ][ Help
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Report Manipulation

Lucity typically provides a Summary report and a Detail report for each module. The Summary report
is great for a quick overview of many records. The Detail report usually shows all of the fields within a
module. It is much easier to delete fields and sections and move things around than it is to add
information. We’ll go over the steps to manipulate a report below:

1. Copy the ReqgDetail.rpt report. This copy is just to “play” with so does not need to be
exported or saved. (Copy and Paste)

2. Open ReqDetail - Copy.rpt.
3. Removing Sections:

» If a section type has multiples (a, b, c...) then all but one may be removed by right
clicking to the left of the report section and selecting Delete Section

e Right click on the left margin of the Detail g section and select Delete Section.
The g section is removed and the Details sections will now rearrange their
lettering. The old h section is now g.

> Some Sections cannot be removed but the information within them can be deleted.

e Right click in the left margin of the Page Header section and choose Select All
Section Objects.

e Then press delete.
» Another option is to suppress a section.

e Right click in the left margin of the Detail c section and choose Suppress (No Drill-
Down).

4. Moving fields around within a report can be challenging. In this example, Detail a section, we
will move Home Phone and Work Phone up to just below Phone Number.

a. To make room for these fields, place the cursor to the left of the report on the right
edge of the ruler strip where the field is to be inserted. You’ll see a single line with
double arrows.

b. Click, hold, and slightly wiggle, pulling to the right as you release to create a section
break.

c. Click and drag the section break line to make room for the new fields.

d. Hold the Shift key and click Home Phone, RQ_HM_PHN, Work Phone and RQ_WK_PHN
to highlight the fields to be moved.

e. Click and drag the fields beneath Phone Number.

Right click in the Details section next to Phone Number and select Merge Section
Below.

Note: The Merge function may have caused the check next to Do Not Disclose to
“disappear”. Right click on the check box and select Move >> To Back.

5. Report sections can be switched by clicking and dragging to the new location.

o Click and drag section Dk to beneath Da. This is now the new Db section.

Note: Section Expert may also be used to Insert, Delete, Merge and move sections.
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6. The report page orientation is another way to add room or shrink a report. Landscape mode is
always helpful if you need to add a couple of fields or see all of the text on one line. This
option is found in File > Page Setup. . . > Orientation. Example 8

Removing Parameters

Parameters are special fields that query the user for information to be used in the report before the
report will run. Common parameters used in Lucity reports include subtitles and date queries.

o These can be removed by clicking on the Parameter field and selecting Delete.

The report no longer uses the parameter field, but the parameter exists in Field Explorer. Unused
parameter fields have been an issue in some of the Web reports.

To permanently remove the parameter field in Field Explorer:
o Right click on the specific parameter field and select Delete
OR
o Click the parameter field and press the delete key.

» Parameter fields are recognizable by the “?” at the beginning of the field:

“Report Sublitie

In V2016r2 there are two new options available through the Admin Portal to suppress the subtitle
parameter for Dashboard and/or Web reports.

Inserting an Agency Logo

Summary of Requests

You may want to have your agency logo appear on your customized reports. This helps identify the
report as one of your own.

The image to be added to the report should be a Bitmap, TIFF, JPEG or PNG type.
To insert an agency logo in our example report (LC_ReqSum.rpt), complete the following steps:
1. You may need to make space in the report for your logo.

a. Right click somewhere to the left of the report in the Page Header section and select
Insert Section Below.

b. In the new PHb section left margin, click and hold, the cursor should turn into a hand.
c. Drag up into the PHa section and release. The two sections have switched places.

d. Place the cursor over the line between sections PHa and PHb (it should turn into
double horizontal lines with an arrow pointing up and one pointing down).

e. Click and drag down to increase the PHa section size so that it can accommodate the
logo.
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2. Toinsert a logo into the Page Header a section, perform one of the following steps:
o Click on Insert and select picture.
OR

o Click on the Insert Picture icon F&
Browse out to the location of your logo file and double click to add it to the report.

4. You can resize the logo by clicking and dragging the corners and edges. You can change the
placement of the logo by clicking and dragging the entire picture.

5. Resize sections as necessary.

6. Finally, right click in the Page Header a section and select Merge Section Below. (optional)
You now have one Page Header section. Save and Close the Report.

Note: It is possible the attached image will increase the file size over the limit your Web
server can accommodate. A possible work around is using a snipping tool to copy/paste the
image into the report.

Datasource

If standard reports are copied and pasted instead of exported and then run or verified in the Crystal
software, the original Lucity connection information is maintained, but the connection information
specific to the customer’s database won’t be available. Thus, the report will be unable to find the
proper database tables. You should receive a warning message similar to the following - Select No:

Remove Table =]

The database table "SWPUMPLH" cannot be found, Proceed ko remove this table from the repork?

Yes ] Mo |

If you receive the warning message displayed above, you have the following options:

» Delete this copied report and export the report from the Lucity module. This process was
explained previously.

» You can manually point each table in the report to the correct datasource.

The above options will repoint the connection strings. This will allow you to run the report in Crystal
Reports, which is the quickest way to test the report modifications.
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Set Datasource Location

Below, we’ve described the steps needed to set the Datasource Location for reports with database
connectivity errors. Remember, you’ll need to complete these steps if you’ve performed a “Save As”
or copied and pasted a report and received a warning message informing you that certain database
tables could not be found.

1. Within the open report, click on Database in the toolbar at the top of the screen.

2. Click on Set Datasource Location. The following dialog will appear:

”
[Z Set Datasource Location @

Change the location of the data source by selecting the cument database (or table) and choosing the database (ortable) to
replace it with. Then click Update.

Current Data Source:

=) ] report

BN Gavorkon]

Froperties
WKREQ
WKREQSTR
: WKWOMWO
=-Ha Subreparts

(- (2 GBAWork 001

Replace with:

[#)-[Z]Cument Connections Update
(- [C]) Favorites

D History

B-[Z]Create Mew Connection
(#1271 Repository

Close ] [ Help

3. In the bottom window, open the Create New Connection folder.

NOTE: Lucity 2019 release moved to a new SQL Server driver for Crystal Reports. This accommodates
the possibility of the TLS 1.0 and TLS 1.1 protocols being disabled. The 2019 release will install this new
driver with the Lucity Report Server (a new installer).

Custom reports will continue to work unless TLS 1.0 and 1.1 have been disabled. If they have been
disabled, then custom reports will need to be updated to run in Lucity.

If a report is going to be edited or created, then the driver may need to be added to the workstation.
The necessary driver is: Microsoft OLE DB Driver 18.1 For SQL Server (select the 64 bit version)

https://docs.microsoft.com/en-us/sql/connect/oledb/download-oledb-driver-for-sql-
server?view=sql-server-2017

Desktop reports (ODBC Connections) may have similar issues if TLS 1.0 and 1.1 are disabled. To correct
this, the latest ODBC SQL Server driver will need to be installed on any machine where Lucity Desktop
will run reports. The driver will not be automatically installed with Lucity Desktop. The report tables
do not need to be repointed.
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Desktop
For Desktop open ODBC.

CDBC (RDO) o)
Data Source Selection
Choose a data source from the list or open a file dsn from the browse
button
Select Data Source: @
Data Source Mame: GBAWater730 -
GBAWater740
GBAWater750
GBAWater760
GBAWorc001
| GEAWar002
i GBAWorkD15
GBAWorkc140 i
GBAWork 145 [
GBAWork710
GBAWor 720 e
||
i Find File DSN: (@]
|
M FileDSN:
|
Il Enter Connection String: ®
|
B Connection Sting:
|
|
<Back || MNed> | [ Fnsh | [ Cancel | [ Hep |

In the ODBC dialog, click on the correct Datasource name and then click Next.

o For example, here we’ve selected GBAWork001.

Web (Version 2018r2 and older)

For Web if you are using SQL Server you will then be prompted to select a provider. Use the
Microsoft OLE DB Provider for SQL Server as shown below. Then click Next.

OLE DB (ADO) X]

OLE DB Provider
Select a provider from the list or select a data link file.

Provider: Microsoft OLE DB Provider for DTS Package &
Microsoft OLE DB Provider for Indexing Serv —
Microsoft OLE DB Provider for Intemet Publis
Microsoft OLE DB Provider for ODBC Drivers
Microsoft OLE DB Provider for OLAP Service -
Mncrosoft OLE DB Provnderfor Oracle e
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Oracle will select Microsoft OLE DB Provider for Oracle. Then click Next.

Web (Version 2019 and newer)

For Web you will then be prompted to select a provider. Use the Microsoft OLE DB Driver for SQL
Server as shown below. Then click Next.

AN b4

o
m

OLE DB Provider
Select a provider from the list or select a data link file.

Provider: Micros 0l F OB Provider M
< Ticrosoft OLE DB Driver for SGL Server
Micros TOVIQET 10r Analysis Servi

Microsoft OLE DB Provider for QDBC Drivers
Microsoft OLE DB Provider for Oracle
Microsoft OLE DB Provider for Search
Microsoft OLE DB Provider for SQIL Server
Microsoft OLE DB Simple Provider

M5 DataShape e
N1l E MO Drrsidar frar Minrnonf Dirscton: Sam
< >

Desktop or Web

At this point you need to know the server for the Lucity data and the User ID and Password. This is
specific to your agency. Lucity does not have this information!

4. Now enter the Connection information.

o For SQL Server, include the SQL Server Name, User ID, Password, and Database.

OLE DB (ADO) [X]

Connection Information
Provide necessary information to log on to the chosen data source.

Server: MYSERVER\Mylnstance v
User ID: !GBA_USER }
Password: | .ee f
Database: \GBAWork] v
Integrated Security: ]

[ < Back ]L__Nexh ] l Finish J [ Cancel J [ Help J
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o For Oracle, include the Service, User ID, and Password.

Oracle Server @

Connection
Service: | MYINSTANCE \
User ID: iGBA_USER |
Password: {oool ‘
08S Authentication: ]

Nexd [ Frsh || Cancel | [ Hep |

Once the connection is created you will need to remap the datasource or if that fails to work then

you will need to individually (manually) map every table from the report one at a time. Don’t forget
the tables in the Subreports!

5.You’ll return to the Set Datasource Location dialog. First try repointing the data source.

e In this case, repoint GBAWork001 to GBAWork015. Highlight GBAWork001 in the
‘Current Data Source:’ section.

e Highlight the GBAWork015 in the ‘Replace with:’ section

e then click on Update (If the Update button is greyed out then you will need to map
the tables individually.)
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Desktop

.
|4 Set Datasource Location ﬂ

Change the location of the data source by selecting the cument database (or table) and choosing the database (ortable)to
replace it with. Then click Update.

Cument Data Source:

@ l WKREQ
r . =-E WKREQSTR

_ - [E WKWOMWO
Ha

B A
| o) @EGEAW::H{{H]'I

Replace with:

Li—_l--[:_ICreate Mew Connection - Update

- [[ ] Access/Excel (DAQ)

- (CIADO.NET (¥ML) —
i#-((1) Database Files

I:l Exchange 5.5 Message Tracking Log
f Cl Exchange Message Tracking Log
D Legacy Exchange

+- [ Mailbox Admin

EI DODBC {HDO}

m

B . LucityDev =
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Web

@ Set Datasource Location

Change the location of the data source by selecting the cument database (ortable) and choosing the database {ortable)to

replace it with. Then click Update.

Curmrent Data Source:

=[] report
- i Ict-sql-071'dev2008
#-E5 Properties
- [ WKREQ
- [E WKREGNOT
- [ WKREGSTR

Replace with:

I:l History

- (Z]Create New Connection

G- [Z) Access/Excel (DAD)

G- (CADO.NET (XML}

[:l Database Files

[#)-[Z2) Exchange 5.5 Message Tracking Log
I:I Exchange Message Tracking Log
CI Legacy Exchange

- (22 Mailbox Admin

- [Z30DBC (ROO)

- (CA0lap

=-[ZJOLE DB (ADO)

----- 3 Make New Connection

El@; barbarapinkston‘sglexpress
i ] Add Command

.. Lucity

1. (T el /Evrhanns
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6. If repointing the data was unsuccessful then expand the Tables in the ‘Replace with’ window.

@ Set Datasource Location M

- -

Change the location of the data source by selecting the cument database (or table) and choosing the database (or table) to
replace it with. Then click Update.

Cument Data Source:

= 2] report

- GBAWorkD
Properties
E WKREQ
-EE WKREQSTR
L @B wKwoMwo
C-MEa Subreports

(- BB GEAWork001

Replace with:

=] ook <] [ Udas
--[B8) PTHHSYNCH m
-5 PTHHSYNSTAT i
--[BE PTIMPCONFIG

--[B5) PTIMPMAP

[ --[F PTIMPSET

[ PTINV

-85 PTLOCATION

-8 PTPARTCOST

| --[B5] PTPARTHC 5

[ Close ] [ Help ]

7. Next, you’ll have to click on each table in the top window (Current Data Source) and find its
match in the bottom window (Replace With). Click on the matching table name and then
press Update.

o Asyou can see in the example below, we’ve selected the WKREQ table in both
windows.

L2 Bl
[Z Set Datasource Location ﬂ

. -

Change the location of the data source by selecting the cument database (or table) and choosing the database (or table) to
replace it with. Then click Update.

Cument Data Source:
=) [2] report

WKWOMWO
=)-@a Subreports
-EAGEAWokD1

Replace with:
[ WKPROJT Update
[ WKPROJTS N ,ID
- [E] WKPROPERTY
| - [E] WKPTASK

-] WKREQNOT
- [E] WKREQSTR
| - [BE] WKREQTRAK i

Close ] [ Help

8. After updating each table listed, click Close.
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Note: Make sure to perform these steps with the Subreport tables as well!!

Note: If the matching table names don’t appear in the bottom window, open the Synonyms
or Views tables and look for them there. Once the database is unified (version 2015R2 or
later) Synonyms or Views should not be necessary unless the client has created a special
View. If the database is unified and the table list cuts off, not showing the bottom of the
alphabetical list, then check the Options > Database tab and make sure the “Stored
Procedures” is unchecked.

If a field type has changed or been removed from the table since the report was last updated then
there will be an issue with Field Mapping and you will see something similar to this:

¥ Map Fields S|

Unmapped Figlds

-3 Report Fields =6 GBAWorkDD1 Map
E-E WKWOTRAK =-E WKWOTRAK
=Y\ K_TRACK| fem= WK_MOD_BY
L.m=m WE_DESC Lm=m WK_CRT_BY [¥| Match type

Mapped Fields

=8 Report Fields =i GBAWorc001 Unmap
- WKWOTRAK =25 WKWOTRAK
femm WE_BY mm WK_BY
.mm WK_DT emm WK_DT
Lemm WE_TM L@ WK_TM
[ ok [ cancel || Hep |

e Sometimes unchecking the “Match type” checkbox will show the field to Map To but sometimes
it doesn’t.

e In Lucity 7.5 Work module > Tracking grid, the Tracked Item and Description fields were
changed from a Text type field to a Memo type field. There was no option to match the
Unmapped Fields to so selecting OK allowed the rest of the mapping to complete. When going
into the Tracking subreport, these fields had been removed.

rTrac:king1 < 3 S 3
tem " * " Description "By _ Date " Time

[ W K_BY T Eon @A

e These fields needed to be manually brought back into the report with the new field types. The
fields have the same name; they are just a different type of field that allows more data.
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Converting Desktop Reports to use in the Web

Custom Reports that have been created for the desktop version of Lucity will NOT work in the Web
application as is. To convert a report from a desktop Lucity report to a Web report, complete the
following steps:

1. Make a copy of the desktop report and give it a new name (maybe add Web to the end of the
file name). Open the Web report in Crystal Reports.

2. Go to Database >> Set Datasource Location.
3. Follow the steps for repointing the tables for Web as described in the previous section.

Note: The converted report needs to be added to the appropriate module in Web.

Adding a Report to the Module
Desktop

To use any new or revised reports within Lucity, you’ll need to add them to the module where you wish
to view them. Open the desired module. (ex. Requests)

1. Click on Reports .
2. Select Add.

Click on the box with three dots _I next to Report File Path.
4. Find the report directory with the new report and double click on the report (LC_ReqSum.rpt).

Enter the report name and give it a description.

FReport Mame:

IFiequest Summary Feport

Dezcription: (255 characters Max]

Fequest summary with Categary, Follow-Up, and 3 &)

6. Select Save. This report is now available to be used within the module.
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Accessing Reports in Lucity - Desktop

Within a module you may use any of the reports available in the reports dialog box. Frequently used
reports can be added to the Quick Reports option (drop down arrow next to the Report icon). This can
be set up in the Reports dialog.

Right click on the Report Title and select the type of Quick Report you would like saved. This setting is
on a User Login basis. This allows various users to set up their own Quick Reports in whichever manner
they’d like to see them.

View Report

Print Report

Export Report...

Add...
Edit...
Delete

Properties...

Add to Quick Reports -This Rec Only
Add to Cuick Reports - Filtered
Add to Cuick Reports - All Records

Rermowe from

¢ heports

The report will be displayed with the hand ¥ icon before the report name.

5 Crew Azzignment Report - Al Addresses
[ ¥ CT Bun Total Summary
5 CT wis by Category

Another means to access a frequently used report is to simply add a number in front of the name to
bump it to the top of the list.

Fﬁ Dialog

Reparts:

%) 1-ark RequestAafark. Order B eview
B Affected Utility wiark Higtary Beport
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Web

[;]or

Starting with version 2015, new custom reports may be uploaded using Lucity Web. The system will
place the report in the report-share (Hive) automatically.

In Lucity Web, open the module you would like to add the report to.

2. Click the Reports Ebutton on the toolbar. The Report tool opens.
3. To add a new report, click the Add button. The following dialog appears:

V2015

Add Report

Report Mame:

Repart Description:

Repart File Path:

Choose File to Upload:

Report Group (optional): [Mone] - |
(=) Standard Report () Quick Report - All Records

() Quick Report - Filtered Set () Quick Report - Current Record Only

Cancel Save

V2015r2

“Add Report Al

Report Name: ||

Report Description:

Subdirectory that Report will be stored in:|

fCustomReportFolderi\
Choose File to Upload: | f::
Optional Report Group: | [Mone] - |
. ]
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Report Name:

Report Description:

Subdirectory that Report will be stored in: (%CustomReportFolder%!)

Choose File to Upload:

|
Optional Report Group:

Report Name:

Report Description:

Subdirectory that Report will be stored in: (%CustomReportFolderd\)

Choose File to Upload:

Choose file | No file chosen
Optional Report Group:

Cancel
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V2019r2

Add Report

Report Name:

Report Description:

Subdirectory that Report will be stored in: (%CustomReportFolder!)

Choose File to Upload:

SELECT FILES...

Optional Report Group:

Crystal Enterprise CUID:

4. Enter the Report Name and Report Description.
5. In the Report File Path, enter the name of the subfolder (Optional) to which you want to
upload the report file (ex. Work, Sewer) or leave blank.

Note: Reports are automatically uploaded to the location specified in the Lucity
Administration Tool's “Path where Reports are stored (Reports Hive)” setting, which may be
found in the System Settings > (Documents or Reporting section depending on the Lucity
version).

Note: If the folder name entered does not exist, the system will create a folder with that
name within the folder to which the reports are uploaded.

6. Under Choose File to Upload, either select or drop the .rpt file you would like to upload to the
web server. This will put the report into the location created for Custom Web reports that was

designated in the System Settings Report File Path.

Note: The name of the .rpt file being uploaded cannot match any other .rpt files.
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Accessing Reports in Lucity - Web

V2015

Assign the report to a Group (optional).

Add Report
Report Name: |WD Resource Custom Report
Report Description: Modified WO Resource repart

Report File Path: | Work |
C j - ;mem TS TEET-T .|
Report Group (optional): | [Mene] z ]>
(#) Standary nepore - i b - e

() Quick Report - Filtered Set (_) Quick Report - Current Record Only
Cancel Save

Choose or change the Type of report:

o Standard Report - The report is generated when the user clicks the Report tool,
selects the report and chooses how to run it.

o Quick Report - All Records - Adds the report to the Quick Report drop-down list,
located next to the Report tool. The report always runs against all records.

o Quick Report - Filtered Set - Adds the report to the Quick Report drop-down list,
located next to the Report tool. The report always runs against the current filter set.

o Quick Report - Current Record Only - Adds the report to the Quick Report drop-down
list, located next to the Report tool. The report always runs against the current
record.

Add Report

Report Name: WO Resource Custom Report

Report Description: Modified WO Resource report

Choose File to Upload: |WOResoumeCustomWeb.rpt U
|

Report File Path: |W0rk
T et
(») Standard Report () Quick Report - All Records >
() Quick Report - Filtered Set (_) Quick Report - Current Record Only
Cancel Save
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For V2015r2 these options are available in the Edit mode.

For V2016 and newer the Quick Report option may be added through the Quick Report drop
E
down arrow @

G-y eaaw® ,ESE

¥d My Quick Reports
[ Main Task Detail Report (Filtered Records) |
101 (Monthly Open Work Orders Chart by Status/Cat (All Records) |

( < Add Quickkﬂgﬁ > ]

Or through the Report tool where the reports are listed. Click on the report to be setup as

Quick then select Add Quick Report . The Create Quick Report dialog will open
where the various reporting options can be setup.

Create Quick Report For : Main Task Detail Report

A A
——— All Records E Filtered Records Selected Records
— j

As

Cancel

Groups can be setup or deleted in the Manage Report Groups option found in the Report Dialog.

Reports For Work Orders

All Records v Manage Report Groups

Reports may be assigned to groups in Add or Edit mode.

Optional Report Group:

When a report has been assigned to a group and the Group is selected, then a list of only the reports
assigned to the group will show.

Example 9
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